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Why is accessibility important in academia?
Before many of the disability and rehabilitation acts were passed, access to 
welcoming and inclusive academic education remained a very exclusive priv-
ilege. Access to buildings, student resources, and even education eligibility 
could be hindered based on one’s disability. Thankfully, after years of 

protests from disability act-
ivists, the Rehabilitation Act 
of 1973 was passed, becoming 
one of the first and most influ-
ential laws for disability 
rights. Section 504 of the 
Rehabilitation Act of 1973 
requires that all educators 
must accommodate all stu-
dents with disabilities for the 
right to equal academic oppor-
tunities. You can learn more 

about this act by accessing the ADA website for the Rehabilitation Act of 
1973.

However, you should not just follow the Section 504 guidelines simply 
because it’s the law. It’s really important that you make sure to design your 
courses, documents, and materials inclusively and with everyone in mind. For 
a very long time, and even still today, many students have had to 'self-adapt' 
to their work and school lives in order to succeed. Being a professor is 
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difficult, and being a professor that accommodates many different back-
grounds and experiences is even more challenging. Accessibility might at 
first seem tedious or counter-intuitive once you start to design accessible doc-
uments, but in the long run, you'll be helping both you and your students by 
creating the best, most inclusive documents out there.

For more information on why accessibility is important, go to the Resources 
page of this guide to see the compiled list of links pertaining to good access-
ibility practices.

TABLE OF CONTENTS 6



Different approaches to accessible design
People usually approach accessibility through something called the medical 
model, which tries to indicate thresholds and spectrums of “normal” human 
functions to diagnose disability. While this approach is helpful for a doctor 
who is tasked with diagnosing disabilities, society does not need to look at 
other human beings through a lens of who has “normal” functionality. 
Instead, you should try to approach disability through the Social model.

Adopting the social model with disability awareness

The social model puts the focus on society’s shortcomings with inclusivity 
for disabled peoples. Instead of viewing disability as something that needs to 
be remedied due to an individual person’s abilities, remedies and rami-
fications on the people’s environment is needed instead. This allows society 
to anticipate the needs of all users so equitable involvement can be done for 
the entire population, regardless of one’s disability. This is crucial for an aca-
demic setting! No student should feel disadvantaged because of their dis-
ability, and it’s important to not diagnose students’ abilities yourself; it's best 
to leave that job to medical professionals.
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Resources for learning about disability awareness and inclusive design

Microsoft has a great resource for using inclusive design when creating your 
projects and documents. Use their Inclusive Design website to learn more 
about what makes approaching accessibility through a social and inclusive 
lens important.

A helpful practice for approaching accessibility through the social model is to 
use user profiles when designing your documents. User profiles help design-
ers create their projects with specific people in mind, all of which have their 
own accommodations and needs that must be met. UX Magazine's article on a 
Web for Everyone is a great link and resource to use for designing your doc-
uments with user profiles in mind.
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Consistency in document design
Everyone likes consistency in their work and school environments. When it 
comes to designing your documents for class or for your colleagues, it's 
important to make sure you organize and create your information in an easy 
to understand and navigable manner. It can be very unfortunate when a stu-
dent has trouble navigating an inconsistent document, and we want to make 
sure that no student ever feels left out or confused when it comes to under-
standing the courses you create. Having inconsistency in document design 
causes errors in accessibility programs and tools that students use, and it’s 
important that we create our documents for students’ needs. Clear and con-
sistent navigation in your courses will allow students to focus on your content 
rather than on how to find it.

Adhering to web accessibility guidelines while developing your online course 
will benefit all students, including those with visual, hearing, mobile, and 
learning disabilities. At first, it might feel tricky to adopt this new habit of 
styling your documents in clear, defined layouts with organizational tools. 
However, it's truly easier for everyone; for both you and your students!
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"Requiring use of an emerging technology in a classroom environment when 
the technology is inaccessible to an entire population of individuals with dis-
abilities... is discrimination prohibited by the Americans with Disabilities Act 
of 1990 (ADA) and Section 504 of the Rehabilitation Act of 1973 (Section 
504) unless those individuals are provided accommodations or modifications 
that permit them to receive all the educational benefits provided by the tech-
nology in an equally effective and equally integrated manner."

Make sure you understand the laws behind creating accessible documents by 
reading the currently established accessibility laws. The ones most important 
for your purposes are the Americans with Disabilities Act, the Rehabilitation 
Act, and the Individuals with Disabilities Education Act.
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Visuals and color
Visuals are incredibly essential when focusing on document design. How you 
format your visuals affects how assistive technologies and mobile devices 
present information to the user, and you always want your information to be 
displayed as it’s meant to be presented. Properly formatted documents are 
more understandable and accessible, and properly formatting your images and 
visuals is extremely crucial.

Alt-text

One of the most important parts of images in document design is alt-text. Alt-
text is written to explain and capture the essence of an image for screen read-
ers or for students who access documents and websites solely through text. 
It's important to use alt text that accurately describes the image that you are 
using. Without alt-text, a user might completely miss a very crucial piece of 
information that is only made available via an image.

Visuals and color contrast

In addition to using proper image formatting, a good rule of thumb for your 
document design is to avoid distracting blinking content such as gifs, as it can 
cause seizures to occur in people with photosensitive disorders.
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Lastly, use enough color contrast between your font colors and background 
colors. Without sufficient color contrast, people who have low-vision or are 
color blind will have a hard time reading your content. Go to WebAIM's 
color contrast checker to test the colors you want to use for your document. 
You can also use the Web Accessibility Guidelines color contrast page from 
STVDIO to find good color contrast examples for text and backgrounds. For 
regular Word documents and academic papers, generally sticking to one or 
two colors is best. Using too many colors can be distracting for your students. 
When in doubt, simple black text on a white background always works won-
ders.
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Checking for proper accessibility in Word
When designing your documents, you might miss an accessibility feature here 
and there. Always use Word's accessibility checker after you've finished work-
ing on a document.

 1. Go to the Review tab.

 2. Select the Check Accessibility section.

 3. Click on the Check Accessibility button.
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 4. Fix any errors in the Accessibility panel. The accessibility checker 
provides you with a list of errors, warnings, and tips. When you click on 
an error or warning, instructions on how to fix it appear below in "Addi-
tional Information".
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How to create Headings with Styles
Headings are very important for organizing an informational hierarchy in 
your documents. Headings also help screen readers properly organize and 
read aloud titles on the page. In order to properly use headings in Word, you 
must use Styles.

 1. Select the text that you want to make into a heading.

 2. Go to the Home tab.

 3. Choose the appropriate heading level from the Styles group.

Additional Headings and Styles tips

Heading 1 should only be used ONCE per page. Heading 2, 3, etc. can be 
used multiple times. (DO NOT skip heading levels!)
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For additional ways to use Styles, right click on the style you want to edit and 
click Modify. Adjust the following options in the Styles formatting menu. 
Don't forget to think about readability, visual hierarchy, and color contrast 
when modifying your styles.

TABLE OF CONTENTS 17



Adding alt-text to images
Alt-text is used if the image is corrupt and does not show up on a document, 
and it used for screen readers and text based operating systems. Without alt-
text, a student may be missing crucial information on a document. If your 
image only reinforces what is already said in your written text, you can omit 
alt-text by marking an image as decorative.

 1. Right click on the image and select Edit Alt Text. If you want to change 
the format and position of an image, select Format Picture.

 2. Write a detailed description of the image in the Alt Text Window. If the 
picture is fully decorative, mark the 'Mark as decorative' box so screen 
readers read the picture appropriately.
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How to add and edit hyperlinks
If you reference a separate website Word, you should create a hyperlink for 
that site. This allows students to easily click on your link and access the site 
you're referencing directly from your document.

 1. Type out text that describes the destination of the link. Do not type 
'click here' for a hyperlink, as that does not describe the link's des-
tination and is inaccessible.

 2. Select the text you want to create a hyperlink for, right click on the text, 
and choose the Hyperlink options from the menu.

 3. Enter a URL address in the Address section of the Insert Hyperlink pop-
up.

 4. Click the OK button to save the link.
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Accessing the screen reader function in Word
Using Word's Read Aloud function allows you to hear how your document 
sounds with a screen reader, which is helpful for students who use text-to-
speech programs or other types of screen readers. It can also be helpful for 
catching editing and syntax errors that are easier to notice when spoken aloud 
rather than read.

 1. Go to the Review tab

 2. Select the 'Read Aloud' Function to access Word's screen reader. There 
is a backwards and forwards button to move the location of where the 
screen reader reads, as well as a pause and play button.

 3. Press the play/pause button to stop the reading. To adjust the screen 
reader's settings, click the speaker button with the cog. You can adjust 
the speed of the screen reader, it's volume, and the speaker's voice in the 
screen reader's settings.
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Accessibility checking PDFs
Before sending out your PDF documents to your students and colleagues, it's 
good practice to check if your PDF is fully and completely accessible. By 
using Adobe Acrobat DC's accessibility checker, you ensure that your PDF 
can be read by third party accessibility programs accurately and as intended.

 1. Go to the Tools section.

 2. Open the Accessibility options.

 3. Click the Accessibility Check option or the Accessibility Report, depend-
ing on the function needed.

 l Accessibility checking a document shows errors that come up in 
Adobe Acrobat DC and where to fix them. Usually this is the 
option frequently selected, as it displays all of the accessibility 
errors in your document and how to fix each individual error.

 l An accessibility report tests whether a PDF document passes many 
qualifications for proper PDF accessibility requirements.
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Converting a Word document to a PDF
Depending on what you need your document for, you can easily create a PDF 
of your finished Word document entirely in Microsoft Word.

 1. Finish your document to be fully accessible in Word before converting it 
to a PDF.

 2. Click the File tab and select Save as.

 3. Select PDF in the Save as type field (*.pdf.)

 4. Fill out the File name field.

 5. Click on the More Options button and then the ‘Options...’ button that 
appears. Make sure the boxes for ‘Document structure tags for access-
ibility’ and ‘Create bookmarks using Headings’ are checked.

 6. Click OK and Save. The new PDF is now tagged with all of the text 
formatting, meaning that your new PDF is fully accessible with page 
headings and lists to be correctly interpreted by a screen reader.
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Checking OCR support in Adobe Acrobat DC
OCR is an incredibly useful accessibility tool for scanned PDF documents, 
such as a chapter you've scanned in a book or a physically scanned article. 
OCR stands for Optical Character Recognition and is used to electronically 
convert images and text into a machine-encoded program, or in other words, 
text-based operating systems and screen readers. This means that text from a 
scanned PDF like a book chapter is recognized and able to be read aloud 
using OCR. Making sure your PDF documents are OCR approved is crucial 
for creating accessible documents.

 1. Open the scanned PDF file.

 2. Open the Tools panel and click 'Scan & OCR.'

 3. Click the Recognize Text button in the OCR window. Click 'In This 
File.'

 4. Click the Recognize Text button in the new window and wait for the 
OCR to run through your entire document.
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 5. Go back to the first Recognize Text button and click 'Correct Recog-
nized Text.'

 6. Correct each problem in the new Correct Recognized Text window and 
select 'Accept' after each new error that pops up. This makes sure your 
document is absolutely accessible to all screen readers. You can also 
select text yourself to make sure it all reads correctly.
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Additional accessibility resources
 l Disability Services at UMass Amherst. Use this link to find more mater-

ials on how to create your courses and documents with accessibility in 
mind.

 l Disability Services Instructor Website for Courses and Accommodation 
letters. This link provides important online courses and documents for 
understanding campus's accessibility and disability services resources.

 l Instructional Design, Engagement and Support (IDEAS) Group. This 
link is useful for designing your courses with accessibility in an online 
setting. 

 l UMass Amherst Faculty Handbook on Accessibility. Use this link to 
access UMass's full and comprehensive accessibility guide for faculty.

 l UMass Amherst Disability Resources for Students. Make sure to know 
what resources are available for your students with this link.

 l Web Content Accessibility Guidelines. For creating material for the 
internet and public access, use this link to view the proper accessibility 
guidelines for all web and public content.

 l Microsoft's Inclusive Design Website. This link is helpful for learning 
how to use inclusive design for online and print materials.

 l UX Magazine's article on a Web for Everyone is a great  resource to use 
for designing your documents with user profiles in mind.
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 l WebAIM's color contrast checker. Use this link to test the colors you 
want to use for your document for proper color contrast.

 l Web Accessibility Guidelines color contrast page from STVDIO is a 
great tool for finding good color contrast examples for text and back-
grounds.

 l ADA website for the Rehabilitation Act of 1973.
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About the author
Hi! I'm a graduating senior at UMass Amherst 
studying English, technical writing, and creative 
writing. I first started my undergraduate education 
at Ithaca College, transferred to Holyoke Com-
munity College for my associate’s degree in Lib-
eral Arts, and then found my home at UMass 
Amherst. I grew up around Amherst myself, hav-
ing gone to high school in South Hadley at the 
Pioneer Valley Performing Arts Charter Public 
School. If you ever want to know what's fun to do 
around the Pioneer Valley, I'm your guy.

When I'm not working on sound design or a technical writing project, you 
can find me writing fiction, poetry, and recording original music. I grew up 
playing jazz and R&B in high school and still pursue that passion today. You 
can learn more about me and my professional and creative work by going to 
my personal, portfolio website.

Thank you for taking the time to read my manual! This project would not be 
possible without you.
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Colophon
This manual was written in English 381, a technical writing class at UMass 
Amherst during Patrick Olszewski's spring semester, 2022. It was written dur-
ing Olszewski's final semester at UMass with the help of his wonderful team 
of fellow technical writing students. He has his peers to thank for their won-
derful workshop suggestions and great collaborative skills. Teamwork makes 
the dream work.

This manual was written using MadCap Flare software. The manual is based 
on a current accessibility PDF document from Holyoke Community College. 
A lot of the topics on HCC's manual were tested and updated for this access-
ibility manual’s construction. This manual uses Microsoft Word 365 and 
Adobe Acrobat DC as software examples for writing accessible documents.

All of the screenshots  were taken by Olszewski using a Windows PC. All of 
the other photos are used fairly under the creative commons licensing for per-
sonal and commercial use. The color contrast image in the 'Visuals and color' 
topic page was used with CC licensing from Pixabay.

The manual's logo was designed using Adobe Illustrator. Times New Roman 
is the default font for all of the manual's font-family styling.

 

This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 
International License.     
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